S Collibra

Collibra On-the-Go for Excel

User Guide

Version 1.0



Contents

Contents .. 1
What is Collibra On-the-Go for Excel? ... ... . . .. 1
Installing Collibra On-the-Go for EXcel .. ... . . 3
Compatibility .. 3
Let' s get started ... .. L 4
Determine which of the installation steps have been carriedout ... ... .. ... 4
| don't have the Collibra On-the-Gotab .. .. ... 4
Download the Collibra On-the-Go for Excel add-in manifestfile ... ... ... .. ... ................ 6
Upload the Collibra On-the-Go for Excel add-in to Microsoft Excel ... ... ... ... 6
Launch the Collibra On-the-Go for Excel add-in in Microsoft Excel ... ... .. ... ... .............. 7
S N NG N L 1
Working with Collibra On-the-Go for EXcel ... ... ... e 13
Collibra On-the-Go tabin EXcel ... . 14
LOOK UP @TESOUICE .. ... e 14
Importing views from your Collibra Data Governance Center ... ... ... .. 16
Wildcards and symbols for searching ... .. .. . 17
LiNKed VWS . 18
KNOWRN ISSUBS . . ... o 20
GlOSSaNY . ..o 23






Chapter 1

What is Collibra On-the-Go for Excel? - -
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Collibra On-the-Go for Excel is an add-in that brings some of the Collibra Data Governance ~  * * = * *

Center functionality to your Microsoft Excel user experience. ... ..

The add-inenablesyouto: e e

o Searchforresourcesinyour Coliorabcc.
e Importviews from ColliborabGC. e e e e
« Manage the imported data and update your linked views withasingle click. =~ =
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Installing Collibra On-the-Go for Excel - -
In this section we describe how to install Collibra On-the-Go for Excel.
Compatibility REES
Collibra On-the-Go for Excel is compatible with the following versions of Microsoft Office:

o Office365 L,
o Office 2016 forMac e e e

o Office 2016 forWindows
o Office Online e e

Note To use the Collibra On-the-Go for Excel add-inand ensure a secure connection . . . . .
with your external data and services, you must use a secure protocol, suchas HTTPS. - . . . .
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Let's get started

The installation process is a three-step process:

1. Download the Collibra On-the-Go for Excel add-in manifest file.
2. Upload the add-ininto Microsoft Excel.
3. Launchthe add-inin Excel.

One or all of these steps may have already been carried out by your administrator or IT
department.

« | know that none of the installation steps have been carried out.
See Download the Collibra On-the-Go for Excel add-in manifest file.

« I'm not sure which, if any, of the installation steps have been carried out.
See Determine which of the installation steps have been carried out.

Determine which of the installation steps
have been carried out

Open Microsoft Excel. Do you have the Collibra On-the-Go tab?

J F = Workbook1

Insert Page Layout Formulas Data Review View Collibra On-the-Go

. . -\: v X= Smartart v i] Store o v -
& LIL Q/ | A

PivetTable Recommended Table Pictures Shapes é@ Screenshot « a My Add-ins * Bing People Recommended pisv
PivotTables Maps Graph Charts ‘

« Yes - there’s nothing else to do. You're ready to use Collibra On-the-Go for Excel.
o No -seeldon't have the Collibra On-the-Go tab.

| don't have the Collibra On-the-Go tab

If you don't have the Collibra On-the-Go tab, check if the add-in has been uploaded to Excel.
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Steps

1 Open Excel.

? mukg.  [Whatoee
Office for Mac |Inthe Insert tab, click Add-ins, and then click (missing or bad snip-

pet) next to My Add-ins.

Office for Win- | Inthe Insert tab, click Add-ins:
dows

« If your administrator uploaded the add-in, it will appear under
the My Add-ins tab.

« If youuploaded the add-in, it will appear under the Shared
Folder tab.

Office Add-ins

MY ADD-INS | SHARED FOLDER | STORE

+4j|. Collibra On-the-Go
S)i; Colibra

Office Online | Inthe Insert tab, click Add-ins:

« If your administrator uploaded the add-in, select the Admin
Managed tab, and then click Upload My Add-in.
« If youuploaded the add-in, select the My Add-ins tab, and then
click Upload My Add-in.
Office Add-ins pload by Ade-in

MY ADD-INS | MY ORGANIZATION | ADMIN MANAGED | STORE

3 Do you see the Collibra On-the-Go add-in?

« Yes -click the add-in.
» The Collibra On-the-Go tab is displayed and you're ready to use Collibra On-
the-Go for Excel.

o No - Upload the Collibra On-the-Go for Excel add-in to Excel.
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Download the Collibra On-the-Go for Excel
add-in manifest file

To download the add-in manifest file, enter the following URL in your browser and save the file
to aknown location: https://<your DGC environment>/otg/office/index.html

Note The add-ininstallationfile is linked to a specific instance of Collibra Data
Governance Center. That means that when you start using Collibra On-the-Go for Excel,
the data you retrieve will come from that same instance of your Collibra DGC.

What's next?

« Upload the Collibra On-the-Go add-in into Microsoft Excel

Upload the Collibra On-the-Go for Excel add-
in to Microsoft Excel

After you or someone in your organization has downloaded Collibra On-the-Go for Excel the
add-in manifest file, you need to upload the add-in to Excel.

Upload the add-in

The following table includes external links to detailed instructions for uploading the add-into
Excel.
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Office 365 |Yes See Publish an Office Add-in via Centralized Deployment.
No You need access to the Office 365 admin center to access
the Collibra On-the-Go add-in after downloading it from
your Collibra Data Governance Center. Ask your Collibra
DGC administrator or IT department for help with this.
Office for Not applicable See Sideload Office Add-ins for testing.
Windows
2016
Office for Not applicable See Sideload an Add-in on Office for Mac.
Mac 2016
Office Not applicable See Sideload Office Add-ins in Office Online for testing.
Online
1
What's next?

o Launch the Collibra On-the-Go for Excel add-inin Microsoft Excel

Launch the Collibra On-the-Go for Excel
add-in in Microsoft Excel

To start using Collibra On-the-Go for Excel, you need to launch the add-inin Excel.

Prerequisites

1. You have downloaded the Collibra On-the-Go for Excel add-in manifest file.
2. Youhave uploaded the Collibra On-the-Go for Excel add-in to Microsoft Excel.


https://docs.microsoft.com/en-us/office365/admin/manage/manage-deployment-of-add-ins?view=o365-worldwide
https://dev.office.com/docs/add-ins/testing/create-a-network-shared-folder-catalog-for-task-pane-and-content-add-ins
https://docs.microsoft.com/en-us/office/dev/add-ins/testing/sideload-an-office-add-in-on-ipad-and-mac
https://docs.microsoft.com/en-us/office/dev/add-ins/testing/sideload-office-add-ins-for-testing
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Steps

Follow the appropriate steps, based on your operating system.

Note Inthe steps below, we refer to the Insert tab in the ribbon.
Excel File Edit View( Ihsert YFormat Tools Data Window Help
® i = (LI T

Home Page Layout Formulas Data Review View

Office for Mac

1. Openanew or existing workbook in Excel.
2. Inthe Insert tab, click Add-ins, and then click (missing or bad snippet) next to My Add-ins.

eee MU S & -

Home Page Layout Formulas Data Review View

) . » . =

T e POt B B A L

PivotTable Recommended Table Pictures Shapes L@' Add-ins Recommended >~ L
PivotTables Charts

a
Al v fx i] Store

4 My Add-ins Bing People
.’ 4 M: el h
| Developer Add-ins

=% Collibra On-the-Go

|Note Depending on the size of your Excel window, you may not see this button:

.’T

Add-ins _nthis case, click directly on & My adg-ins[ ]
3. Click Collibra On-the-Go.
» The Collibra On-the-Go tab appears in Excel.
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Office for Windows

1. Openanew or existing workbook in Excel.

2. Inthe Insert tab, click Add-ins, and then click:
o The My Add-ins tab if your administrator uploaded the add-in to Excel.
o The Shared Folder if you uploaded the add-in to Excel.

Office Add-ins

MY ADD-INS | SHARED FOLDER | STCRE

+*j|. Collibra On-the-Go
=) Celiibra

3. Click Collibra On-the-Go.
» The Collibra On-the-Go tab appears in Excel.

Office Online

1. Openanew or existing workbook in Excel.

2. Inthe Insert tab, click Add-ins, and then click:
o The Admin Managed tab if your administrator uploaded the add-in to Excel.
o The My Add-ins if you uploaded the add-in to Excel.

Upload My Add-in

Office Add-ins
3. Click Upload My Add-in.
4. Click Collibra On-the-Go.
» The Collibra On-the-Go tab appears in Excel.
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Signingin

You will be prompted to signin at the first action you take in the Collibra On-the-Go tab. Tosign = = = * *

in, enter your Collibra Data Governance Center credentials. e e
Hello JEIR I
Welcome to Collibra On-the-Go for Excel,a e e
companion add-in to your Collibra Data Governance e e e e
Center. .
Username e e e e e
Admin e s e e e
Password ol

. . . L] L]

Note Collibra On-the-Go for Excel does not currently support signonviasingle sign- = |
onauthenticationservices. L

.....
-----
.....
-----
-----
.....

1
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Working with Collibra On-the-Go for
Excel

In this section, we describe how to use the Collibra On-the-Go for Excel features.

Collibra On-the-Go tab in Excel

Look up aresource

Importing views from your Collibra Data Governance Center

Wildcards and symbols for searching

Linked views

-----
.....
-----
-----
.....
ooooo
.....
.....
-----
.....
-----
.....
-----
.....
-----
.....
-----
.....
-----
ccccc
-----
.....
-----
.....
-----
-----
-----
.....
-----
.....
.....
-----
.....
ooooo
-----
.....
-----
.....

-----
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Collibra On-the-Go tab in Excel

Collibra On-the-Go for Excel appears as a new tab in your menu bar.

Home Insert Page Layout Formulas Data Review View Collibra On-the-Go r

Y= [= L

Lookup Import @Linked
selection view WM views

1 Collibra On-the- |Provides access to Collibra On-the-Go for Excel features.
Go tab

2 |Lookup selection | Enables you to search for resources in your Collibra Data
Governance Center and show the results in Excel.

3 |Import view Enables you to import views from your Collibra DGC into Microsoft
Excel.
4 | Linkedviews Enables you to manage yourimported views.

Look up a resource

The Lookup selection feature enables you to search for resources (meaning assets,
communities or domains) in your Collibra Data Governance Center and show the results in
Excel.

Note You canuse wildcards to aid your search. See Wildcards and symbols for
searching.

Prerequisites

« You have an Excel file open.

14
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Steps

1. Inthe Collibra On-the-Go tab, click Lookup selection.
» The searchfield appears.
2. Enteraquery and then press Enter on your keyboard.
OR
Click on the cell that contains the term you want to look up.

What's next?

If the term you are searching for exists as a resource in your Collibra DGC, every instance of
the term is shown as aresult in the search panel.

For every result, you can see:

« the resource name.

the resource definition or description.

the breadcrumb for the resource's location in your Collibra DGC.
optionto openan asset page in Collibra DGC.

Tip You canclick onthe number of search results to launch the search and see the
results in your Collibra DGC.

oy
L ]

A~ customer ey

24 results found for customer

Open an asset page from your search results

If a search for an asset in your Collibra Data Governance Center yields one or more results, you

can open the resulting asset page(s) directly in Collibra DGC from within Excel, by clicking
Openinbrowser next to the desired asset(s).

15
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Importing views from your Collibra Data
Governance Center

Whenyouimport a view, you create a link to the source view in your Collibra Data Governance
Center. You can then work with the data in Microsoft Excel for your reporting needs.

You can search for aview in your Collibra DGC:

« By application, for example, Business Glossary, Reference Data or Catalog.
« By organization, meaning a community or domain.
o Bythe view's URL.

You canalso import the global view. The global view includes every asset in your organization’s
Collibra DGC instance, independent of community, domain or asset type. For more information
onthe global view, refer to the Collibra Data Governance Center User Guide.

Note
« Youcanonly import aview from your Collibora DGC, meaning you cannot export
the data back into Collibra DGC.
« ltis not possible to import:
o Views for which the hierarchy feature has been enabled in Collibra DGC.
o Working views, meaning a view that has been edited in Collibra DGC and not
yet saved. Once the edited view has been saved or reverted to the original
view, you canimport it.

Import a view

You canimport views and then work with the data in Microsoft Excel for your reporting needs.

Steps

1. Inthe Collibra On-the-Go tab, click Import view.
» The Import view pane appears.
2. Do one of the following:
o Select aview based on the application to which it belongs.
o Search foraview by organization or the view's URL.
o Select aglobal view.

16
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3. Whenyou've found the view you want to import, click onit.
» You are notified that the view has been successfully imported. The view appears as a
new worksheet in Excel and also appears in your linked views.

Glossary
My views (1)  All (9)  Pinned (5)

L) Business Terms
View for displaying all business terms

@ Successfully imported

Wildcards and symbols for searching

If you want to find something, but are not quite sure of the name, you can use wildcards.
You can use the following wildcards:
? Replaces any single character.

Example: by typing ?ar, you can find Car, Bar, Tar, and so on.

Replaces any string of characters.

Example: by typing C*r, you can find Car, Crosshair, and so on.

~ Represents a fuzzy search, words with spelling similar to the search query.

Example: by typing Owi~, you can find Ozi, Zowie, Bowie, and so on.

! Excludes words.

Example: by typing !David Bowie, you can find Lester Bowie, Joe Bowie, and so
on.

If you want to find a piece of text, you can use double quotation marks.

Example: by typing "Customer account"you can find 'This is a customer account', but not ‘New
Customer' or 'Account’.

17
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Linked views

Linked views enable you to manage your imported views in a single click.

Refresh linked views

You can update the views that you've imported with any changes that have been made to the
respective source views in Collibra Data Governance Center.

Prerequisites

« Youhave imported one or more views from Collibra DGC into Microsoft Excel.

Steps

1. Inthe Collibra On-the-Go tab, click Linked views.

» The Linked view pane appears.
o,

2. Torefreshaspecific view, click R efresh underneath the view you want to

refresh, in the Linked view panel.

Linked Views

This is an overview of the views currently referenced
from this workbook.

2 linked views

All Issues
View for displaying all issues

Worksheet All Issues
Table All_lssues

() Refresh Open in browser

18
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Open a source view in Collibra Data Governance

Center from within Excel

If you have imported a view, you can open the source view in a browser window directly from

with Excel.

Prerequisites

« You have imported one or more views from Collibra DGC to Microsoft Excel.

Steps

1. Inthe Collibra On-the-Go tab, click Linked views.
» The Linked view pane appears.

2. Click Openinbrowser under the view for which you want to open the source view in Col-

libra DGC.
» The source view in Collibra DGC opens in a browser window.

s ZB Create

Q Search...

(#4) CJ Business Glossary

Business Terms ~

View for displaying all business terms

9 tasks

Revert to original
last changes 4 minutes ago

> QB o °
Y Name t Definition ‘ Business Steward ‘ Status Domain Asset Type Comr
business term sz @ szymon Lukowicz e Users  Candidate glossary Business Term comn
business term sz1 Candidate glossary Business Term comn
business term sz2 Candidate glossary Business Term comn
business term sz3 Candidate glossary Business Term comn
business term sz4 Candidate glossary Business Term comn
» Country Candidate New Business Terms Business Term Data
» Currency Conversion Candidate New Business Terms Business Term Data
» Customer Candidate New Business Terms Business Term Data
» Customer Revenue Total amount of ... Candidate New Business Terms Business Term Data
» Order Candidate New Business Terms Business Term Data
13 (top-level )

110 11-13 »

19
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Known issues

The following items are known issues that will be fixed in the next version of Collibra On-the-

Go for Excel.

You are working with data in Excel and the
Search panelin the Collibra On-the-Go for
Exceltab is open.

If you click ona cell, a searchis launched for
the contents of the cell, in your Collibra Data
Governance Center. If you then click on
another cell, a search should automatically be
launched for the contents in the new cell;
however, the new search is not launched if you
are using Office 2016 for Windows.

You are working in a linked view, you have
entered datain a cell outside of the table
object inyour linked view, and you want to
refresh the linked view.

Example: you have imported a view that has
100 rows, and you have entered data in one or
more cells inrow 105. Sometime after you
imported the view, 10 new assets were added
inyour Collibra DGC, so that the source view
now has 110 rows. If you now try to refresh the
view, you might encounter problems and you
might lose all of the datainyour linked view.

20
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The Linked view panelis openinthe Collibra | The import is successful, but you have to
On-the-Go for Excel tab and youimport a manually reload the Linked view panel to see
view. the view listed in your linked views.

The following figures show you where to find
the Reload link if you are using Office for Mac
or Windows. If you are using Office Online, you
can simply refresh the webpage.

Reload via Office 2016 for Mac

Collibra On-the-Go (*)
. Collibra On-the-Go .
Linked \ Collibra
Thisi Get Support
IS IS an ov¢
from this wo|
View Source

2 linked vie Security Info

©J Business Glossary

Approved assets
View for displaying all approved assets

Worksheet Approved assets
Table Approved_assets

() Refresh Open in browser

Reload via Office 2016 for
Windows

Collibra On-the-Go A
2L Collibra On-the-Go |
Linked V ;e Collibra

This is an ove Get Support

from this wor

1 linked vie' Attach Debugger

Security Info
©J Business Glossary
Acronyms
View for displaying all acronyms

Worksheet Acronyms
Table Acronyms

() Refresh Open in browser
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Glossary

A

Admin
Aresource role; the administrator of a resource who can do everything in that resource,
including assigning and removing roles.

Articulation score
Indication of how well an asset is defined according to the Articulation Calculator.

Asset
The fundamental building block for which to capture information; examples are: KPI, business
term, code, data element and so on.

Asset type

The fundamental building block for which to capture information; examples are: KPI, business
term, code, data element and so on.

Assignment
Determines the visibility of a feature in the GUI.

Attribute

A distinctive, indivisible piece of information (field) that can be assigned to an asset.

Attribute kind
The kind of information that an attribute type can be; text, binary choice, multiple selection.

Attribute type

Specifies what the attribute represents (definition, example, note, security classification, ...).

-23-
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B

Business asset
An asset type related to a business model; terms, reports, KPIs.

C

Code list

A domain that can only contain code values and code sets.

Code set

A grouping of code values.

Code value

A specific code.

Community
A grouping of one or more users or user groups. A community owns one or more domains and
sub-communities. A community represents the business context of an asset.

Corole
The reverse role in a fact type or relation type.

D

Data issue

A problem related to issue management; also referred to as issue.

Domain
A logical container for assets. An asset is unique in its domain. A domain is owned by exactly
one community. A domain represents the logical context of an asset.

-24 -
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F
Fact type
A bidirectional relation between two assets in terms of role and corole.
G
Gilobal role
Arole that can only be assigned to a user and that determines who has access to which part of
the Data Governance Center.
Glossary
A domain that can only contain business terms, KPIs and acronyms.
Governance asset
An asset type related to data governance; business rules, data rules, policies.
H
Head
The first asset or asset type of arelation between two assets or asset types.
M
Metamodel
The model as defined by default in the Data Governance Center Settings.
R
Reference data
Any kind of data that is used solely to categorize other data found in a database, or solely for
relating data in a database to information beyond the boundaries of the enterprise.
Relation type

A fact type between two asset types.

-5
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Resource
An asset, adomain or acommunity.

Resource role
Atype of role that can be assigned to one or more resources.

Role
A grouping of rights and responsibilities that can be assigned to users or user groups.

S
Stakeholder
Aresource role; a user who wants to be involved/notified and can only provide
comments/reviews.
Steward
Aresource role; a user who is responsible at the content level and can make all changes ina
domain/community apart from assigning roles.
Subject matter expert (SME)
Aresource role; a user who can be requested to provide feedback on changes.
=
Tall
The second asset or asset type of arelation between two assets or asset types.
Technology asset
Anasset type related to technology; database, system.
U
User

An individual who has access to Collibra Data Governance Center.

-26-
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User group
A grouping of users.

\'

View
A selection of table elements in the GUI; can be saved and displayed locally.

-27 -
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	 Signing inYou will be prompted to sign in at the first action you take in the Collibra On-the-Go tab. To sign in, enter your Collibra Data Governance Center credentials.Collibra On-the-Go for Excel does not currently support sign on via single sign-on authentication services.
	 Working with Collibra On-the-Go for ExcelIn this section, we describe how to use the Collibra On-the-Go for Excel features.Collibra On-the-Go tab in Excel Look up a resource Importing views from your Collibra Data Governance Center Wildcards and symbols for searching Linked views Collibra On-the-Go tab in ExcelCollibra On-the-Go for Excel appears as a new tab in your menu bar.No.Element nameDescription1Collibra On-the-Go tabProvides access to Collibra On-the-Go for Excel features.2Lookup selectionEnables you to search for resources in your Collibra Data Governance Center and show the results in Excel.3Import viewEnables you to import views from your Collibra DGC into Microsoft Excel.4Linked viewsEnables you to manage your imported views. Look up a resourceThe Lookup selection feature enables you to search for resources (meaning assets, communities or domains) in your Collibra Data Governance Center and show the results in Excel.You can use wildcards to aid your search. See Wildcards and symbols for searching.PrerequisitesYou have an Excel file open.StepsIn the Collibra On-the-Go tab, click Lookup selection.The search field appears.Enter a query and then press Enter on your keyboard.ORClick on the cell that contains the term you want to look up.What's next? If the term you are searching for exists as a resource in your Collibra DGC, every instance of the term is shown as a result in the search panel.For every result, you can see: the resource name.the resource definition or description.the breadcrumb for the resource's location in your Collibra DGC.option to open an asset page in Collibra DGC.You can click on the number of search results to launch the search and see the results in your Collibra DGC. Open an asset page from your search resultsIf a search for an asset in your Collibra Data Governance Center yields one or more results, you can open the resulting asset page(s) directly in Collibra DGC from within Excel, by clicking Open in browser next to the desired asset(s).Importing views from your Collibra Data Governance CenterWhen you import a view, you create a link to the source view in your Collibra Data Governance Center. You can then work with the data in Microsoft Excel for your reporting needs.You can search for a view in your Collibra DGC:By application, for example, Business Glossary, Reference Data or Catalog.By organization, meaning a community or domain.By the view's URL.You can also import the global view. The global view includes every asset in your organization’s Collibra DGC instance, independent of community, domain or asset type. For more information on the global view, refer to the Collibra Data Governance Center User Guide.You can only import a view from your Collibra DGC, meaning you cannot export the data back into Collibra DGC.It is not possible to import: Views for which the hierarchy feature has been enabled in Collibra DGC.Working views, meaning a view that has been edited in Collibra DGC and not yet saved. Once the edited view has been saved or reverted to the original view, you can import it.Import a viewYou can import views and then work with the data in Microsoft Excel for your reporting needs.StepsIn the Collibra On-the-Go tab, click Import view.The Import view pane appears.Do one of the following:Select a view based on the application to which it belongs.Search for a view by organization or the view's URL.Select a global view.When you've found the view you want to import, click on it.You are notified that the view has been successfully imported. The view appears as a new worksheet in Excel and also appears in your linked views.Wildcards and symbols for searchingIf you want to find something, but are not quite sure of the name, you can use wildcards.You can use the following wildcards:WildcardDescription?Replaces any single character. Example: by typing ?ar, you can find Car, Bar, Tar, and so on.*Replaces any string of characters. Example: by typing C*r, you can find Car, Crosshair, and so on.~Represents a fuzzy search, words with spelling similar to the search query. Example: by typing Owi~, you can find Ozi, Zowie, Bowie, and so on.!Excludes words. Example: by typing !David Bowie, you can find Lester Bowie, Joe Bowie, and so on. If you want to find a piece of text, you can use double quotation marks.Example: by typing Customer account you can find 'This is a customer account', but not 'New Customer' or 'Account'.Linked viewsLinked views enable you to manage your imported views in a single click.Refresh linked viewsYou can update the views that you've imported with any changes that have been made to the respective source views in Collibra Data Governance Center.PrerequisitesYou have imported one or more views from Collibra DGC into Microsoft Excel.StepsIn the Collibra On-the-Go tab, click Linked views.The Linked view pane appears.To refresh a specific view, click underneath the view you want to refresh, in the Linked view panel.Open a source view in Collibra Data Governance Center from within ExcelIf you have imported a view, you can open the source view in a browser window directly from with Excel.PrerequisitesYou have imported one or more views from Collibra DGC to Microsoft Excel.StepsIn the Collibra On-the-Go tab, click Linked views.The Linked view pane appears.Click Open in browser under the view for which you want to open the source view in Collibra DGC.The source view in Collibra DGC opens in a browser window.
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	 Known issuesThe following items are known issues that will be fixed in the next version of Collibra On-the-Go for Excel.ContextKnown issueYou are working with data in Excel and the Search panel in the Collibra On-the-Go for Excel tab is open.If you click on a cell, a search is launched for the contents of the cell, in your Collibra Data Governance Center. If you then click on another cell, a search should automatically be launched for the contents in the new cell; however, the new search is not launched if you are using Office 2016 for Windows.You are working in a linked view, you have entered data in a cell outside of the table object in your linked view, and you want to refresh the linked view.Example: you have imported a view that has 100 rows, and you have entered data in one or more cells in row 105. Sometime after you imported the view, 10 new assets were added in your Collibra DGC, so that the source view now has 110 rows. If you now try to refresh the view, you might encounter problems and you might lose all of the data in your linked view.The Linked view panel is open in the Collibra On-the-Go for Excel tab and you import a view.The import is successful, but you have to manually reload the Linked view panel to see the view listed in your linked views. The following figures show you where to find the Reload link if you are using Office for Mac or Windows. If you are using Office Online, you can simply refresh the webpage.Reload via Office 2016 for MacReload via Office 2016 for Windows
	 GlossaryAAdminA resource role; the administrator of a resource who can do everything in that resource, including assigning and removing roles.Articulation scoreIndication of how well an asset is defined according to the Articulation Calculator.AssetThe fundamental building block for which to capture information; examples are: KPI, business term, code, data element and so on.Asset typeThe fundamental building block for which to capture information; examples are: KPI, business term, code, data element and so on.AssignmentDetermines the visibility of a feature in the GUI.AttributeA distinctive, indivisible piece of information (field) that can be assigned to an asset.Attribute kindThe kind of information that an attribute type can be; text, binary choice, multiple selection.Attribute typeSpecifies what the attribute represents (definition, example, note, security classification, …).BBusiness assetAn asset type related to a business model; terms, reports, KPIs.CCode listA domain that can only contain code values and code sets.Code setA grouping of code values.Code valueA specific code.CommunityA grouping of one or more users or user groups. A community owns one or more domains and sub-communities. A community represents the business context of an asset.CoroleThe reverse role in a fact type or relation type.DData issueA problem related to issue management; also referred to as issue.DomainA logical container for assets. An asset is unique in its domain. A domain is owned by exactly one community. A domain represents the logical context of an asset.FFact typeA bidirectional relation between two assets in terms of role and corole.GGlobal roleA role that can only be assigned to a user and that determines who has access to which part of the Data Governance Center.GlossaryA domain that can only contain business terms, KPIs and acronyms.Governance assetAn asset type related to data governance; business rules, data rules, policies.HHeadThe first asset or asset type of a relation between two assets or asset types.MMetamodelThe model as defined by default in the Data Governance Center Settings.RReference dataAny kind of data that is used solely to categorize other data found in a database, or solely for relating data in a database to information beyond the boundaries of the enterprise.Relation typeA fact type between two asset types.ResourceAn asset, a domain or a community.Resource roleA type of role that can be assigned to one or more resources.RoleA grouping of rights and responsibilities that can be assigned to users or user groups.SStakeholderA resource role; a user who wants to be involved/notified and can only provide comments/reviews.StewardA resource role; a user who is responsible at the content level and can make all changes in a domain/community apart from assigning roles.Subject matter expert (SME)A resource role; a user who can be requested to provide feedback on changes.TTailThe second asset or asset type of a relation between two assets or asset types.Technology assetAn asset type related to technology; database, system.UUserAn individual who has access to Collibra Data Governance Center.User groupA grouping of users.VViewA selection of table elements in the GUI; can be saved and displayed locally.
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